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What Is Calendar?
Windows Calendar combines a month-at-a-glance calendar and a daily appointment book. Calendar has
two views: Day and Month. In the Day view, you can:

Write down appointments and save a record of appointments in a daily calendar.
Set an alarm in a daily calendar for an appointment time.
Add notes to a scratch pad.

In the Month view, you can:
Look up dates on a monthly calendar.
Mark days on a monthly calendar.
Add notes to a scratch pad.
Related Procedures



Concepts
Calendar's Day View
Calendar's Month View

Procedures
Adding Notes to the Scratch Pad
Entering Appointments
Marking Dates in a Month
Moving Around the Day View
Saving New or Renaming Existing Files
Setting Alarms for Appointment Times



Calendar's Day View
When you first start Calendar, an untitled Calendar window appears, displaying the Day view for the 
current date. Day view shows one-hour time intervals. The first hour that appears at the top of the 
window is 7:00 a.m.

In the appointment area, you can record appointments and set alarms for appointments. You can move 
to any day between January, 1980, and December, 2099.

Related Procedures



status line
Shows the current time, as well as the date for a day you move to.
You can double-click the status line to move to the Month view. The month that appears is the month for 
the day in the Day view.



scroll arrows
Move forward or backward a day at a time.



insertion point
The place where text will be inserted when you type.The insertion point appears as a flashing vertical 
bar in the appointment area or scratch pad. The text you type appears to the left of the insertion point, 
which moves to the right as you type.



appointment area
Area for recording appointments and setting alarms.
You can change the intervals between appointment times, the type of clock you want (12- or 24-hour), 
and the starting time. You can also add a special time falling between the regular time intervals.



scratch pad
Area for adding notes.



Procedures
Adding Notes to the Scratch Pad
Adding Special Times
Changing the Day Settings
Entering Appointments
Moving Around the Day View
Setting Alarms for Appointment Times



Calendar's Month View
When you start Calendar, you see the Day view. If you switch to the Month view, you see a whole month
at one time.

You can mark special dates with symbols, such as a box or an "x.". As in Day view, you can move to any
month between January, 1980 and December, 2099.

Related Procedures



status line
Shows the current time, as well as the date for the selected day in a month you move to.



scroll arrows
Move forward or backward a month at a time.
To move to a specific day in the Day view, double-click the day in the monthly calendar.



Procedures
Adding Notes to the Scratch Pad
Marking Dates in a Month
Moving Around the Month View
Switching to the Day or Month View



















New Command

Creates a new file.
When you choose this command, Calendar lets you saves changes to the current file before opening the
new file.

Related Procedure



Open Command

Opens an existing file.
When you choose this command, Calendar lets you save changes to the current file before opening the 
new file.
Select the Read Only check box if you don't want any changes made to the file.

Related Procedure



Save Command

Saves changes to the current file.
When you choose this command, the file remains open so you can continue working on it.

Related Procedure



Save As Command

Saves a new file or an existing file under an additional name.
When you name a new or rename an existing file, if you don't specify an extension, .CAL is automatically
assigned to the filename. If you specify an extension, it overrides any automatic extension.
You might want to rename a file so that you can change an existing file without modifying the original.

Related Procedure



Print Command

Prints a range of appointments.
If you have connected and installed a printer, you can print a range of appointments in the current file. 
Calendar automatically prints to the default printer.

Related Procedures



Procedures
Connecting to Network Printers
Installing New Printers
Printing Appointments



Page Setup Command

Sets the margins, and adds headers and footers to printed appointments.
You can specify:
Margins--Left, right, top, and bottom.
Headers and Footers--Text and/or the following codes:

Type For
&d The current date.
&p Page numbers.
&f The current filename.
&l Header or footer text (typed following the code) justified at the left margin.
&r Header or footer text (typed following the code) justified at the right margin.
&c Header or footer text (typed following the code) centered between the margins.
&t The current time.

Related Procedures



Procedures
Printing Headers and Footers
Setting Margins



Printer Setup Command

Sets printer options for Calendar before printing.
You can:

Select a default printer for Calendar.
Choose Setup and change options for the printer.

The available options depend on the type of printer selected.
Related Procedure



Exit Command

Exits Calendar and closes the Calendar window.
If the file is unsaved, Calendar lets you save it before exiting.



Cut Command

Cuts text from a file and places it onto the Clipboard, erasing the previous Clipboard contents.
You can then use Paste to place the cut text in the same file, another file, or another application.

Related Procedure



Copy Command

Copies text from a file onto the Clipboard, leaving the original intact and erasing the previous Clipboard 
contents.
You can then use Paste to place the copied text in the same file, another file, or another application.

Related Procedure



Paste Command

Pastes a copy of the Clipboard contents at the insertion point or replaces selected text.
You can choose this command repeatedly to paste the Clipboard contents in more than one location.

Related Procedure



Remove Command

Removes all the entries from a range of appointment days in the current file.
To remove or delete an entire file, you must use File Manager.

Related Procedures



Procedures
Deleting Files or Directories
Removing Entries from Appointment Days



Day Command

Switches from the Month view to the Day view.
The mouse shortcut for this command is simply to double-click in the status line (the bar with the date in 
it).

Related Procedure



Month Command

Switches from the Day view to the Month view.
The mouse shortcut for this command is simply to double-click in the status line (the bar with the date in 
it).

Related Procedure



Today Command

Moves to the current day in the Day or Month view.
Related Procedures



Procedures
Moving Around the Day View
Moving Around the Month View



Previous Command

Moves to the preceding day in the Day view or the preceding    month in the Month view.
Related Procedures



Procedures
Moving Around the Month View
Moving Around the Day View



Next Command

Moves to the following day in the Day view or the following month in the Month view.
Related Procedures



Procedures
Moving Around the Day View
Moving Around the Month View



Date Command

Moves to a specific date in the Day or Month view.
When entering a date, you can type any date between January 1, 1980, and December 31, 2099. Type 
dates in either the mm/dd/yyyy or mm-dd-yyyy format. You do not need to type leading zeros for days or 
months. If you type a two-digit number for the year, Calendar assumes the 20th century. The following 
examples show some acceptable date formats:

You can type this For this date
3/16/90 March 16, 1990
11-7-90 November 7, 1990
9/13/2010 September 13, 2010

Related Procedures



Procedures
Moving Around the Day View
Moving Around the Month View



Set Command

Sets and removes an alarm.
Use Calendar's alarm to remind yourself of appointments. You can set the alarm for as many 
appointments as you want.
When the alarm goes off, Calendar alerts you in one of the following ways:

If Calendar is This happens
Active A dialog box reminds you of the appointment
Inactive The title bar at the top of the Calendar window flashes.
An icon The icon flashes.
If you chose the Sound option, the alarm will also beep.

Related Procedures



Procedures
Changing the Sound Options
Removing Alarms
Setting Alarms for Appointment Times



Controls Command

Controls alarm options.
When you choose Controls, you can set the alarm to go off up to ten minutes early. You can also turn the
alarm's sound on or off.

Related Procedures



Procedures
Turning off the Alarm
Setting the Alarm for an Early Ring



Mark Command

Marks and unmarks special days in the Month view.
When you choose Mark, a dialog box opens displaying five symbols. Select the symbols you want to 
display on a selected date in the Month view. Use symbols to call attention to special days such as 
paydays, holidays, birthdays, and anniversaries.

Related Procedure



Special Time Command

Adds and removes special times in an appointment day.
A special time is a time falling between the intervals set in the Day Settings dialog box.

Related Procedure



Day Settings Command

Changes the view settings.
You can specify:

The intervals between appointments.
A 12- or 24-hour clock.
The starting time appearing at the top of the window.
Related Procedure
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Switching to the Day or Month View
To change from the Day to the Month view:

Double-click the status line.

To change from the Month to the Day view:
Double-click the status line to move to the selected day.

Or double-click a specific day.
Keyboard Procedure



Moving Around the Month View

To move to Do this
The next month Click the Right scroll arrow or choose Next from the Show menu.
The previous month Click the Left scroll arrow or choose Previous from the Show menu.
The current month Choose Today from the Show menu.
A specific month Choose Date from the Show menu and type a date. Then click OK.

Click        for an example of a valid date.
Keyboard Procedure



Marking Dates in a Month
To mark a special date:
1 Click the date you want to mark in the Month view.
2 Choose Mark from the Options menu.
3 Select a mark symbol.
4 Click OK.

To remove a mark:
1 Move to the marked date.
2 Choose Mark from the Options menu.
3 Clear the check box of the symbol you want to remove.
4 Click OK.

Keyboard Procedure



Moving Around the Day View

To move to Do this
The previous day Click the Left scroll arrow or choose Previous from the Show menu.
The next day Click the Right scroll arrow or choose Next from the Show menu.
The current day Choose Today from the Show menu.
A specific day Choose Date from the Show menu and type a date. Then click OK.

Click        for an example of a valid date.
Related Procedure
Keyboard Procedure



example
You can type any date between January 1, 1980, and December 31, 2099. Type dates in either the 
mm/dd/yyyy or mm-dd-yyyy format. You do not need to type leading zeros for days or months. If you 
type a two-digit number for the year, Calendar assumes the 20th century. The following examples show 
some acceptable date formats:

You can type this For this date
3/16/90 March 16, 1990
11-7-90 November 7, 1990
9/13/2010 September 13, 2010



Moving to Appointment Times
To move to an appointment time:

Click the time.
Related Procedure
Keyboard Procedure



Entering Appointments
Entering an appointment involves moving the insertion point to a time in the Day view and typing text 
that describes the appointment scheduled for that time.

To enter text for an appointment day:
1 Move the insertion point to the appointment time.

If the time is not visible, use the scroll bar to move the time onto the screen.
2 Type the text.

You can type approximately 80 characters of text describing an appointment. The line scrolls 
horizontally if you continue typing past the end of the line initially shown in Calendar. 

Related Procedure
Keyboard Procedure



Adding Notes to the Scratch Pad
The scratch pad is the area at the bottom of the Calendar window in either the Day view or the Month 
view.

To use the scratch pad:
1 Click in the scratch pad.
2 Type up to three lines of text.
3 Press TAB to return to the appointment area.

When your text reaches the right border of the scratch pad, Calendar automatically wraps the text to 
the next line.

Keyboard Procedure



Moving the Insertion Point
To move the insertion point:

Move the mouse to position the insertion point where you want it and click the left mouse button 
once.

Keyboard Procedure



Selecting Text in Calendar
You cannot select text from more than one appointment at a time.

To select text:
1 Point to the first character you want to select.
2 Hold down the mouse button and drag the insertion point to the last character you want to select.
3 Release the mouse button.

To select a single word:
Double-click on the word.

To cancel a selection:
Click again anywhere in the document to cancel the selection.
Keyboard Procedure



Copying, Cutting, and Pasting Text
With the Cut, Copy, and Paste commands, you can easily copy and move text within a document, 
between documents, and between applications.

To copy and paste or cut and paste text:
1 Select the text.
2 Choose Copy from the Edit menu to copy the text.

Or choose Cut to cut the text.
The text is placed on the Clipboard.

3 Move the insertion point to where you want the text to appear.
Or select text you want to replace.

4 Choose Paste from the Edit menu.
The text is inserted from the Clipboard.

Keyboard Procedure



Removing Entries from Appointment Days
To remove entries from a file:
1 Open the file from which you want to remove appointments.
2 Choose Remove from the Edit menu.
3 To remove appointments over a range of days, type the first date in the From box, then type the last 

date in theTo box.
Or to remove entries from only one appointment day, leave the To box blank.

4 Click OK.
Keyboard Procedure



Setting Alarms for Appointment Times
Calendar has an alarm you can set to remind you of appointments. You can set the alarm for as many 
appointments as you want.

To set an alarm:
1 Move to the appointment time.
2 Choose Set from the Alarm menu.

When the alarm goes off, Calendar alerts you in one of the following ways:

If Calendar is This happens
Active A dialog box reminds you of the appointment
Inactive The title bar at the top of the Calendar window flashes.
An icon The icon flashes.
If you chose the Sound option, the alarm will also beep.

Related Procedure
Keyboard Procedure



Removing Alarms
To remove an alarm:
1 Move to the time the alarm is set for.
2 Choose Set from the Alarm menu.

Keyboard Procedure



Changing the Sound Option
To turn the alarm's sound on or off:
1 Choose Controls from the Alarm menu.
2 Select or clear the Sound check box.
3 Click OK.

Keyboard Procedure



Setting the Alarm for an Early Ring
To set an alarm to go off early:
1 Set the alarm for an appointment time.
2 Choose Controls from the Alarm menu.
3 Type a number from 0 to 10 in the Early Ring box to set the number of minutes an alarm goes off 

before an appointment.
4 Click OK.

Keyboard Procedure



Turning off the Alarm
To turn off the alarm after it goes off:

Click OK if Calendar is the active window.
Or if Calendar is an inactive window, make the window active and click OK.
Or if Calendar is an icon, select the icon and click OK.

Related Procedures
Keyboard Procedure



Procedures
Changing the Sound Option
Removing Alarms



Adding Special Times
A special time is any time that falls between the intervals you set in the Day Settings dialog box. For 
example, no matter what time interval you set, 11:10 is a special time.

To add a special time:
1 Choose Special Time from the Options menu.
2 Type the time in the Special Time box.
3 Select AM or PM if you are using a 12-hour clock.
4 Choose Insert.

To remove a special time:
1 Move the insertion point to the time.
2 Choose Special Time from the Options menu.
3 Choose Delete.

Keyboard Procedure



Changing the Day Settings
To change the day settings:
1 Choose Day Settings from the Options menu.
2 Change the appropriate options and click OK.

Use this option To specify
Interval 15-, 30-, or 60-minute intervals between appointment times.
Hour Format Either a 12-hour or 24-hour clock.
Starting Time The time that appears at the top of the window when you first view an 

appointment day.
Keyboard Procedure



Printing Appointments
If you have connected and installed a printer, you can print a range of appointments in the current file. 
Calendar automatically prints to the default printer.

To print appointments:
1 Choose Print from the File menu.
2 To type a range of appointments, type the beginning date in the From box, then type the ending date 

in the To box.
Or to print one appointment date, leave the To box blank.

3 Click OK.
Related Procedures
Keyboard Procedure



Procedures
Changing Printers and Printer Options
Installing New Printers



Changing Printers and Printer Options
If you have several printers connected to your computer and designated as active printers, you can print 
to one of these printers by selecting it as the default printer.

To change printers:
1 Choose Printer Setup from the File menu.
2 Select the printer that you want to print on.
3 Choose Setup to change printer options.

In the dialog box that appears, the available options depend on the printer you choose.
4 Select the options you want.

For more information on the options, click the Help button in the printer's Setup dialog box.
5 Click OK to close the printer's Setup dialog box.
6 Click OK.

Related Procedure
Keyboard Procedure



Printing Headers and Footers
When you print your documents, you can add explanatory text, the date, a page number, or the filename
as a header or footer on the printed pages. You can also choose whether you want a header or footer to 
be left-justified, right-justified, or centered on the page.

To add a header or footer to the printed document:
1 Choose Page Setup from the File menu.
2 Type the text you want to use as a header or footer in the Header or Footer box along with any of the 

following codes:

Type For
&d The current date.
&p Page numbers.
&f The current filename.
&l Header or footer text (typed following the code) justified at the left margin.
&r Header or footer text (typed following the code) justified at the right margin.
&c Header or footer text (typed following the code) centered between the margins.
&t The current time.
You can include any or all of these codes in a single header or footer. Headers always appear just 
above the top margin and footers appear just below the margin.

3 Click OK.
Related Procedure
Keyboard Procedure



Setting Margins
To set the margins:
1 Choose Page Setup from the File menu.
2 Type the margin settings in the Margins box.
3 Click OK.

Related Procedure
Keyboard Procedure



Creating New Files
To create a new file:

Choose New from the File menu.

Related Procedure

Keyboard Procedure



Opening Existing Files
To open an existing document:
1 Choose Open from the File menu.
2 Select the Read Only check box if you don't want to make any changes to the document.
3 If the file is in the current directory, double-click the name of the file in the Files box.

If the file is not in the current directory, double-click the directory you want in the Directories box. Then
double-click the name of the file in the Files box. 

Related Procedure

Keyboard Procedure



Procedures
Browsing Through the Directories List Box
Creating New Files



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the files and directories located one level closer to a disk's root directory.
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and click OK.



Saving Existing Files
To save changes to an existing file:

Choose Save from the File menu.

Related Procedure

Keyboard Procedure



Saving New or Renaming Existing Files
To save a new file or to save an existing file under an additional name:
1 Choose Save As from the File menu.
2 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
The .CAL extension is automatically assigned to the filename if you don't specify an extension. If you 
specify an extension, it overrides any automatic extension.
If you want to save the file in a different directory, double-click its name in the Directories box. Then 
type the filename.    

3 Click OK.    

Related Procedure

Keyboard Procedure



Procedures
Browsing Through the Directories List Box
Saving Existing Files



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to save a file, you can type the complete pathname 
in the Filename box and click OK.
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Movement Keys
Use the following keys for moving around in Calendar's Day view:

To move Press

To the time above UP ARROW

To the time below DOWN ARROW or 
ENTER

Right one character RIGHT ARROW

Left one character LEFT ARROW

Right one word CTRL+RIGHT ARROW

Left one word CTRL+LEFT ARROW

To the previous screen PAGE UP

To the next screen PAGE DOWN

To the starting time CTRL+HOME

To 12 hours after the starting time CTRL+END

Between the appointment area and the 
scratch pad

TAB

Use the following keys for moving around in Calendar's Month view:

To Press

Move to the week above UP ARROW

Move to the week below DOWN ARROW

Move to the previous month PAGE UP

Move to the next month PAGE DOWN

Move between a date and the scratch pad TAB

Change to the Day view of the selected date ENTER

Text Selection Keys

To select Press

Text one character at a time to the left or 
right. Or, if the character is already selected, 
cancels the selection.

SHIFT+LEFT or RIGHT 
ARROW

One line of text up or down in the scratch 
pad. Or, if the line is already selected, 
cancels the selection.

SHIFT+DOWN or UP 
ARROW

Text from the insertion point to the beginning 
of the line.

SHIFT+HOME

Text from the insertion point to the end of the 
line.

SHIFT+END

The previous word. CTRL+SHIFT+LEFT ARROW

The next word. CTRL+SHIFT+RIGHT 
ARROW



Text from the insertion point to the beginning 
of the scratch pad.

CTRL+SHIFT+HOME

Text from the insertion point to the end of the 
scratch pad.

CTRL+SHIFT+END
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Keyboard: Switching to the Day or Month View
To change from the Day to the Month view:
1 Press ALT and then V.
2 Press M.

To change from the Month to the Day view:
Press ALT and then V. Then press D.

Or use the arrow keys to select a specific day and press ENTER.
Mouse Procedure



Keyboard: Moving Around the Month View
To move around the month view:
1 Press ALT and then S.
2 Press one of the following letters:

Press To move to
N The next month.
P The previous month.
T The current month.
D A specific month. Then type a date and choose OK.

Choose        for an example of a valid date.
Mouse Procedure



Keyboard: Marking Dates in a Month
To mark a special date:
1 Use the arrow keys to select the date you want to mark.
2 Press ALT and then O.
3 Press M.
4 Press TAB until you reach a symbol you want to select.
5 Press the SPACEBAR at each symbol you want to select.
6 Press ENTER.

To remove a mark:
1 Use the arrow keys to select the marked date.
2 Press ALT and then O.
3 Press M.
4 Press TAB until you reach a symbol you want to remove.
5 Press the SPACEBAR to clear each check box you want to move.
6 Press ENTER.

Mouse Procedure



Keyboard: Moving Around the Day View
To move around the day view:
1 Press ALT and then S.
2 Press one of the following letters:

Press To move to
N The next day.
P The previous day.
T The current day.
D A specific day. Then type a date and choose OK.

Choose        for an example of a valid date.
Related Procedure
Mouse Procedure



Keyboard: Moving to Appointment Times
To move to an appointment time:

Use the following keys:

Press To move
UP ARROW To the time above.
DOWN ARROW or ENTER To the time below.
PAGE UP To the previous screen.
PAGE DOWN To the next screen.
CTRL+HOME To the starting time.
CTRL+END Twelve hours after the starting time.

Related Procedure
Mouse Procedure



Keyboard: Entering Appointments
To enter text for an appointment day:
1 Use the UP ARROW or DOWN ARROW keys to move the insertion point to the appointment time.
2 Type the text.

Related Procedure
Mouse Procedure



Keyboard: Adding Notes to the Scratch Pad
To use the scratch pad:
1 Press TAB to move to the scratch pad.
2 Type up to three lines of text.

Mouse Procedure



Keyboard: Moving the Insertion Point
To move the insertion point:

Use the following keys:

Press To move
UP ARROW To the time above.
DOWN ARROW or ENTER To the time below.
RIGHT ARROW Right one character.
LEFT ARROW Left one character.
CTRL+RIGHT ARROW Right one word.
CTRL+LEFT ARROW Left one word.
PAGE UP To the previous screen.
PAGE DOWN To the next screen.
CTRL+HOME To the starting time.
CTRL+END To 12 hours after the starting time.
TAB Between the appointment area and the scratch pad.

Mouse Procedure



Keyboard: Selecting Text in Calendar
To select text:
1 Use the arrow keys to move to the first character you want to select.
2 Press SHIFT.
3 Press the LEFT ARROW or RIGHT ARROW key to move to the last character you want to select in the 

appointment area.
Or press any of the arrow keys to move to the last character you want to select in the scratch pad.

4 Release SHIFT.

To cancel a selection:
Press an arrow key.
Mouse Procedure



Keyboard: Copying, Cutting, and Pasting Text
To copy and paste or cut and paste text:
1 Select the text.
2 Press CTRL+INS to copy the text.

Or press SHIFT+DEL to cut the text.
3 Move the insertion point to where you want the text to appear.

Or select text you want to replace.
4 Press SHIFT+INS.

Mouse Procedure



Keyboard: Removing Entries from Appointment Days
To remove entries from a file:
1 Open the file from which you want to remove appointments.
2 Press ALT and then E.
3 Press R.
4 To remove appointments over a range of days, type a date in the From box, then press TAB and type 

the last date in the To box.
Or to remove entries from one appointment day, leave the To box blank.

5 Press ENTER.
Mouse Procedure



Keyboard: Setting Alarms for Appointment Times
To set an alarm:
1 Move to the appointment time.
2 Press ALT and then A.
3 Press S.

Related Procedure
Mouse Procedure



Keyboard: Removing Alarms
To remove an alarm:
1 Move to the time the alarm is set for.
2 Press ALT and then A.
3 Press S.

Mouse Procedure



Keyboard: Changing the Sound Option
To turn the alarm's sound on or off:
1 Press ALT and then A.
2 Press C.
3 Press TAB.
4 Press the SPACEBAR to select or clear the Sound check box.
5 Press ENTER.

Mouse Procedure



Keyboard: Setting the Alarm for an Early Ring
To set an alarm to go off early:
1 Set the alarm for an appointment time.
2 Press ALT and then A.
3 Press C.
4 Type a number from 0 to 10 to set the number of minutes an alarm goes off before an appointment.
5 Press ENTER.

Mouse Procedure



Keyboard: Turning off the Alarm
To turn off the alarm after it goes off:

Press ENTER if Calendar is the active window.
Or if Calendar is an inactive window, make the window active and press ENTER.
Or if Calendar is an icon, select the icon and press ENTER.

Related Procedures
Mouse Procedure



Procedures
Changing the Sound Option
Removing Alarms
Selecting Windows or Icons



Keyboard: Adding Special Times
To add a special time:
1 Press ALT and then O.
2 Press S.
3 Type the time in the Special Time box.
4 Press ALT+A to select AM or press ALT+P to select PM if you are using a 12-hour clock.
5 Press ENTER.

To remove a special time:
1 Move the insertion point to the time.
2 Press ALT and then O.
3 Press S.
4 Press ALT+D.

Mouse Procedure



Keyboard: Changing the Day Settings
To change the day settings:
1 Press ALT and then O.
2 Press D.
3 Use the LEFT ARROW or RIGHT ARROW key to select 15-, 30-, or 60-minute intervals between 

appointment times.
4 Press TAB and use the LEFT ARROW or RIGHT ARROW key to select a 12-hour or 24-hour clock.
5 Press TAB and type the time that you want to appear at the top of the window when you first view an 

appointment day.
6 Press ENTER.

Mouse Procedure



Keyboard: Printing Appointments
To print appointments:
1 Press ALT and then F.
2 Press P.
3 To print a range of appointments, type the beginning date in the From box, then press TAB and type 

the ending date in the To box.
Or to print one appointment date, leave the To Box blank.

4 Press ENTER.
Related Procedure
Mouse Procedure



Keyboard: Changing Printers and Printer Options
To change printers:
1 Press ALT and then F.
2 Press R.
3 Use the UP ARROW or DOWN ARROW to select the printer that you want.
4 Press ALT+S to change printer options.
5 Select the options you want and press ENTER.
6 Press ENTER.

Mouse Procedure



Keyboard: Printing Headers and Footers
To add a header or footer to the printed document:
1 Press ALT and then F.
2 Press T.
3 Type the header text and/or codes. Then press TAB and type the footer text and/or codes.

Type For
&d The current date.
&p Page numbers.
&f The current filename.
&l Header or footer text (typed following the code) justified at the left margin.
&r Header or footer text (typed following the code) justified at the right margin.
&c Header or footer text (typed following the code) centered between the margins.
&t The current time.

4 Press ENTER.
Related Procedure
Mouse Procedure



Keyboard: Setting Margins
To set the margins:
1 Press ALT and then F.
2 Press T.
3 Press TAB until you reach a margin you want to change.
4 Type the new margin settings.
5 Repeat steps 3 and 4 if you want to change other margins.
6 Press ENTER.

Related Procedure
Mouse Procedure



Keyboard: Creating New Files
To create a new file:
1 Press ALT and then F.
2 Press N.

Related Procedure
Mouse Procedure



Keyboard: Opening Existing Files
To open an existing document:
1 Press ALT and then F.
2 Press O.
3 Press ALT+R and press the SPACEBAR to select the Read Only check box if you don't want to make any

changes to the document. Then press ALT+N.

4 If the file is in the current directory, press ALT+F and use the UP ARROW or DOWN ARROW key to select 
the file.
If the file is not in the current directory,press ALT+D, use the UP ARROW or DOWN ARROW key to select a 
drive or directory, and press ENTER. Then press ALT+F and use the UP ARROW or DOWN ARROW key to 
select the file.    

5 Press ENTER.    
Related Procedure
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Creating New Files



hint
The current directory is shown below the Filename box. Choosing the two periods [..] at the top of the 
Directories box shows the files and directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and press ENTER.



Keyboard: Saving Existing Files
To save an existing file:
1 Press ALT and then F.
2 Press S.

Related Procedure
Mouse Procedure



Keyboard: Saving New or Renaming Existing Files
To save a new file or to save an existing file under an additional name:
1 Press ALT and then F.
2 Press A.
3 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
If you want to save the file in a different directory, press ALT+D and use the UP ARROW or DOWN ARROW 
key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

4 Press ENTER.    
Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Saving Existing Files



hint
The current directory is shown below the Filename box. Choosing the two periods [..] at the top of the 
Directories box shows the directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to save a file, you can type the complete pathname 
in the Filename box and press ENTER.
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          Calendar Quick Looks  
Day View
Month View







Calendar
Combines a month-at-a-glance calendar and a daily appointment book.
In the Month view, a monthly calendar, you can:

Look up dates.
Mark days.
Add notes to a scratch pad.

In the Day view, a daily appointment book, you can:
Write down appointments and save a record of appointments.
Set an alarm for an appointment time.
Add notes to a scratch pad.



application Control-menu



title bar          
Contains the title of the application running in the window, in this case Calendar. The title bar also shows
the file that's open.

Drag the title bar to move an application window on the screen.



Minimize button          
Click the Minimize button to shrink the Calendar window to an icon.



Maximize button          
Click the Maximize button to enlarge the Calendar window to its maximum size.



File menu



Edit menu



View menu



Show menu



Alarm menu



Options menu



Help menu



menu bar          
Contains the names of all the Calendar menus.

Click a menu name to display the menu commands.



time          

Indicates the current time. The line that shows the time is called the status line.



day view scroll arrows          

Arrows on the status line, used to move to the previous or next day.
Click a scroll arrow in the status line to move to another day.



date          

Indicates the date of the selected day. The line that shows the date is called the status line.
Double-click the date to change to the Month view.



appointment time          

The time of the appointment and a place for information about it. If the alarm is set, an alarm icon 
appears to the left of the appointment.



alarm icon          

A bell that indicates that an alarm is set for an appointment.



insertion point          
A flashing bar in an application's window or in a dialog box. The insertion point shows where text will 
appear when you type. The text appears to the left of the insertion point, which is pushed to the right as 
you type.



scroll bar          
A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box, which allow you to move the contents of the 
window or list box.

Click a scroll bar to move the contents one screen.



scroll arrow          

An arrow on either end of a scroll bar, used to move the contents of the window or list box.
Click a scroll arrow to move the contents.



scroll box          

A small box in a scroll bar. The scroll box shows the position of what's currently in the window or list box 
relative to the contents of the entire file or list.

Drag the scroll box to display another part of the contents.



Day view
An appointment book you can use to record appointments and to set an alarm to remind you of 
appointments.

Click an appointment to select it.



scratch pad          

The area below the appointment times where you can create and edit notes.



scratch pad          

The area below the calendar days where you can create and edit notes.



month view scroll arrows          

Arrows on the status line, used to move to the previous or next month.
Click a scroll arrow in the status line to move to another month.



current month
Shows the month and year of the current calendar in month view.

Click a scroll arrow in the status line to change to another month.



Month view
A month-at-a-glance calendar that you can use to look up dates and mark days. Each box represents a 
day.

Click a day to select it.



day          

A day in the Month view.
Double-click a day to see the appointments for that day.



mark          

A symbol , such as an "x," you can choose to mark special dates.
Use the Mark command from the Options menu to mark the selected day.



selected day          

A highlighted day in the Month view.
Double-click a day to see the appointments for that day.



application window
The main window for an application, in this case the Calendar window. It contains the application's menu
bar and main workspace. The Calendar application window can display either the Day view for 
scheduling daily appointments or the Month view for planning monthly events.



window border          
The outside edge of a window.

Drag the window border to change the size of the window.







A
386 enhanced mode
active
active printer
animation
application
application icon
application window
arrow keys
associate
AUTOEXEC.BAT



B
<< button
>> button
Back button
base-level synthesizer
batch file
baud rate
bitmap
branch
browse
byte



C
cascading menu complementary color
CD-ROM compound device
channel CONFIG.SYS
check box Contents button
choose Control menu
Clipboard Control-menu box
close conventional memory
collapse cutout
command
command button
command line



D
data bits Directory Tree window
default button directory window
default printer disk-drive icon
desktop display box
desktop pattern document
destination directory document file
device contention document window
device driver DOS
dialog box drag
directory path drop-down list box
Directory Tree



E
error-checking
expand
expanded memory
extended memory
extended synthesizer
extension



F
file
file information line
flow control
font
font size
format
full-screen application



G
General MIDI Mode standard
group
group icon
group window



H
History button
hotspot
hue
HyperGuide button bar



I
icon
insertion point
International MIDI Association



J
No defined terms.



K
keymaps
keyword
kilobyte



L
list box
local printer
local queue
luminosity



M
maximize MIDI Mapper
Maximize button MIDI sequencer
Media Control Interface MIDI Manufacturer's Association (MMA)
memory minimize
menu Minimize button
menu bar movie file
menu command MSCDEX
menu name multimedia extensions
menu title Multimedia PC
MIDI multitasking
MIDI file



N
network printer
network queue
network server
non-Windows application



O
open
option button



P
parity print option
palette printer-driver file
patch printer font
patchmaps printer queue information line
pathname program file
picture elements program information file (PIF)
pixels program item
playlist program item icon
pointer
port



Q
No defined terms.



R
RGB components
read-only
real mode
Restore button
root directory



S
sample serial port
saturation shortcut key
scaled font size shrink
screen font simple device
screen saver solid color
scroll arrow source directory
scroll bar spin box
scroll box standard mode
Search button status bar
select stop bits
selection cursor synthesizer



T
Task List
text box
text file
title
title bar
topic
track



U
Up button



V
vector font
virtual memory
volume label



W
waveform
WAVE format
wildcard characters
window
window border
Windows application
wrap



X
No defined terms.



Y
No defined terms.



Z
No defined terms.



386 enhanced mode
Provides access to the virtual memory capabilities of the Intel 80386 processor. With virtual memory 
capabilities, Windows applications can use more memory than is physically available. Enhanced mode 
also allows for multitasking of non-Windows applications.



active
Describes the selected window or icon that you are currently working with. Windows always applies the 
next keystroke or command you choose to the active window. If a window is active, it appears in front of 
all other windows on the desktop, and its title bar changes color to differentiate it visually from other 
windows. If an icon is made active, its Control menu appears.
Inactive is the opposite of active and describes windows or icons on the desktop that are not selected.



active printer
An installed printer that has been assigned to a printer port using Setup or Control Panel. More than one
printer can be set up to work on a single port, but only one can be active, since only one printer can be 
physically connected to the port at a time.
An inactive printer is an installed printer that is not currently connected to the printer port.



animation
The display of a series of graphic images, simulating motion. You can play animation files (for example, 
files with the.MMM extension) with the Media Player accessory. Animations are also called movies.



application
A computer program used for a particular kind of work, such as word processing. This term is often used
interchangeably with "program."



application icon          

An icon that represents an application that is running.



application window
The main window for an application. It contains the application's menu bar and main workspace. An 
application window may contain multiple document windows.



arrow keys          

The four arrow keys on your computer keyboard. These keys move the cursor or pointer on your screen 
to locations you choose. Each arrow key moves the cursor or pointer in the direction of the arrow on the 
key. Each arrow key is named for the direction in which arrow points: UP ARROW, DOWN ARROW, LEFT 
ARROW, and RIGHT ARROW.



associate
To assign files that have the same extension to a program. When you choose a file with the specified 
extension, the associated application runs with the file loaded.



AUTOEXEC.BAT
Batch file that lists MS-DOS commands. MS-DOS automatically carries out the commands in your 
AUTOEXEC.BAT file when you turn on your computer. The file is located in the root directory of your first
hard disk, which is usually drive C.
Typically, an AUTOEXEC.BAT file starts memory-resident utilities such as a network and sets up 
environment variables that are used later by applications. In addition, your AUTOEXEC.BAT file might 
set your MS-DOS prompt or start pop-up programs such as Borland's SideKick.



<< button          

Displays the previous topic in a series of topics, until you reach the first topic in the series. Then the 
button is dimmed. Use this button when you want to backtrack through topics the way they are 
organized in HyperGuide.



>> button          

Displays the next topic in a series of topics, until you reach the last topic in the series. Then the button is
dimmed. Use this button to move from topic to topic in the recommended order.



Back button          

Displays the last topic you viewed. HyperGuide moves back one topic at a time, in the order in which 
you viewed them.



base-level synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



batch file
A file that runs a sequence, or "batch," of commands when you type its filename. All filenames of batch 
files end with the extension .BAT, even though you don't have to type this extension to run the batch file.



baud rate
Signalling speed measured by the number of signals per second.



bitmap          

An image stored as an array of bits.



branch          

A segment of the Directory Tree, representing a directory and any subdirectories it contains.



browse
To look through files and directories. In some dialog boxes, the Browse button shows a list of files and 
directories from which you can choose.



byte
The amount of memory space (normally 8 bits) that a computer needs to represent a single character or 
word.



cascading menu          

A menu that opens from a command on another menu.



CD-ROM
Compact Disc-Read Only Memory. An optical data-storage technology that allows large quantities of 
data (such as animations, images, music, and sound) to be stored on a compact disc similar to discs 
used by the music industry.



channel
MIDI uses channels to send messages to individual devices within a MIDI setup. There are 16 MIDI 
channel numbers. Devices in a MIDI setup can be directed to respond only to messages marked with a 
channel number specific to the device.



check box           

A small square box that appears in dialog boxes and can be selected or cleared. When the check box is 
selected, an X appears in the box.



choose
To use key combinations or your mouse to carry out a command in Windows. You often choose a 
command after you have selected an item or made it active.



Clipboard          

A temporary storage area in memory, used to transfer information. You can cut or copy information onto 
the Clipboard and then paste it into another document or application.



close
To reduce a document window or application window to an icon or, in some cases, to remove it from the 
desktop. You close a window by double-clicking the Control-menu box or choosing the Close command 
from the Control menu. When closing an application window, you can choose to save or abandon 
changes to the current document before you close it.



collapse
To hide a level of directory information in the Directory Tree window. When you first start File Manager, 
all directories but the root directory are collapsed.



command          

A word or phrase, usually found in a menu, that you choose to carry out an action.



command button          

A button in a dialog box that carries out or cancels the selected action. Two common command buttons 
are OK and Cancel. The button that carries out the action will often have a label that describes it (for 
example, Open, Create, Install). Another dialog box appears when you choose a command followed by 
ellipses.



command line
Information given to MS-DOS that specifies a command and all the pertinent information to carry it out. 
For example, to start Windows, you type win at the MS-DOS prompt.



complementary color
The color exactly opposite a color on the RGB color wheel. For example, the complementary color of 
blue is yellow.



compound device
Devices, such as the waveform audio driver, that have an associated file and require a filename 
specification when opened.



CONFIG.SYS
A file that defines device drivers and specifies your MS-DOS configuration. For example, a typical 
CONFIG.SYS file might specify the location of the MS-DOS file COMMAND.COM, define an extended 
memory manager, and specify how many files an application can have open at once. MS-DOS runs the 
commands in the CONFIG.SYS file each time you turn on your computer. Your CONFIG.SYS file is 
located in the root directory of your first hard disk, which is usually drive C.



Contents button          

Displays the HyperGuide contents.



Control menu          

The menu in the upper-left corner of a window. The Control menu appears on every application that runs
in a window and on some non-Windows applications. Document windows, icons, and some dialog boxes
also have Control menus.
Control menu commands move, change the size of, and close windows. You can also switch to Task List
by using the Control menu. For non-Windows applications, Control menu commands transfer 
information and perform other functions, depending on the application.



Control-menu box
The box located in the upper-left corner of a window. Clicking the Control-menu box opens the Control 
menu for the window.



conventional memory
The first 640K of memory that MS-DOS uses to run applications. Most computers have at least 256K of 
conventional memory and can accommodate up to 640K of conventional memory.



cutout          
A portion of a Paintbrush drawing you select with the Scissors or Pick tool.



data bits
The bits in each package of data sent between two computers during telecommunication. Most 
characters are transmitted in 7 or 8 data bits.



default button          

The command button in some dialog boxes that is automatically selected or chosen by Windows as the 
most logical or safest choice. The default button has a bold border, indicating that it will be chosen if you 
press ENTER. You can override a default button by choosing Cancel or another command button.



default printer
The printer that Windows applications automatically use when you choose the Print command. You can 
have only one default printer, which must also be the active printer on the port. The printer you use most 
often should be made the default printer.



desktop
The background of your screen, on which windows, icons, and dialog boxes appear.



desktop pattern
A geometric pattern that appears across your desktop. You can design your own pattern or choose one 
of the patterns provided by Windows.



destination directory
The directory to which you intend to copy or move one or more files.



device contention
When several applications simultaneously request use of a peripheral device, such as a printer or 
modem.
Windows automatically handles device contention when all the applications are Windows applications. 
When one of the applications is a non-Windows application, however, the conflict is handled according 
to the options you select in the 386 Enhanced dialog box. This dialog box appears when you choose the 
386 Enhanced icon in Control Panel.



device driver
Tells Windows how to control a piece of hardware. Using Control Panel, you can install device drivers for
your:

Display (monitor)
Keyboard
Mouse
Network



dialog box          

A rectangular box that either requests or provides information. Many dialog boxes present options that 
you must choose from before Windows can carry out a command. Some dialog boxes present warnings 
or explain why a command can't be completed.



directory path          

The directions to a directory or file within your system.
In the illustration, C:\ART stands for the ART directory on drive C. Any commands you use affect the files
and subdirectories in this directory.
When you want to specify a file, make sure the filename follows the directory path.



Directory Tree          

A graphic display of a disk's directory structure. The directories on the disk are shown as branching from
the disk's root directory.



Directory Tree window          

A File Manager window that shows the complete branching structure of the selected disk drive.



directory window          

A File Manager window that lists the contents of a specific directory. The directory window shows all the 
files and subdirectories contained in the directory.



disk-drive icon          

An icon in the Directory Tree window of File Manager that represents a disk drive on your system. 
Different icons depict floppy disk drives, hard disk drives, RAM drives, CD-ROM drives, and network disk
drives.



display box          

A display box is not an option, but a type of text box that shows an example of another option you have 
selected, in this case a sample of the 10 pt, underlined, Helvetica font.



document
Whatever you create with an application, including information you enter, edit, view, or save. A document
can be a business report, a spreadsheet, a picture, and so on.



document file          

Files that are associated with an application. You can start an application and open the associated file by
choosing a document file icon.



document window          

A window inside an application window. Each document window contains a single document or other 
data file. There can be more than one document window inside an application window.



DOS
Disk Operating System, typically known as MS-DOS (Microsoft) or PC-DOS (IBM). This is the underlying
software that must exist for your PC to operate.



drag
A mouse move. You drag a Windows element by pointing to it, holding down the mouse button, and 
sliding the mouse from one spot on the surface of your desk to another and releasing the mouse button.



drop-down list box
A list box that opens and closes in dialog boxes.
Before you open a drop-down list box, it looks like this:

After the list box is open, it looks like this:

NOTE: When the list is longer than the box, scroll bars are provided.



error checking
A method for validating transmissions.



expand
To show hidden directory levels in the Directory Tree. With File Manager, you can expand a single 
directory level, one branch of the Directory Tree, or all branches at once.



expanded memory
Memory in addition to conventional memory that is available to applications. It is allocated in 16K blocks.
Windows makes use of expanded memory only if the /r switch is used at startup. Windows running in 
386 enhanced mode simulates expanded memory for the applications that need it. Windows running in 
standard mode or 386 enhanced mode allows applications to use expanded memory, but does not use 
expanded memory itself in managing applications.



extended memory
Memory in addition to conventional memory that is not readily accessible to MS-DOS or MS-DOS 
applications. Extended memory cannot be used on 8086 and 8088 computers. Windows running in 
standard mode or 386 enhanced mode uses extended memory to manage and run applications.



extended synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



extension
Part of a file or directory name that appears after a period and provides additional information. It usually 
indicates the type of file or directory. For example, program files have default extensions of .COM 
or .EXE .
Many applications include a default extension automatically when you save a file the first time. For 
example, Notepad adds a .TXT extension to all filenames unless you specify otherwise.



file
A document or application that has been given a name. All documents are stored as files in Wiindows.



file information line          

Information specific to each file in a print queue. The information can include these details:
The file's position in the queue or a printer icon if the file is printing.
The title of the print job assigned by the application (if your network software supports this).
What percentage of the file has printed so far.
The size of the file in kilobytes (if the Print File Size command on the View menu is selected).
The time and date you sent the file to Print Manager (if the Time/Date Sent command on the View

menu is selected).
If you are connected to a network printer, the printer queue information line shows the network server 
connection. Any detailed information the network can provide appears in the message box at the upper-
right corner of the Print Manager window. Networks can provide varying degrees of detailed information.



flow control
The method for controlling the flow of information.



font          
A graphic design applied to all numerals, symbols, and characters in the alphabet. A font usually comes 
in different sizes and provides different styles, such as bold, italic, and underlining for emphasizing text.



font size
The height of a printed character, measured in points. One inch equals 72 points. For example, 12-point 
Helv is 12 points high.

The font and font size you use determine the amount of text that fits on one page. 



format
(1) The appearance of text on the pages of a document. (2) To prepare a disk so it can hold information. 
Formatting a disk erases all information that was previously on it.



full-screen application
A non-Windows application that uses the entire screen--rather than a window--to run in the Windows 
environment.



General MIDI Mode standard
A MIDI specification controlled by the MIDI Manufacturers Association (MMA). The purpose of this 
specification is to enable MIDI file authors to create files that sound the same across a variety of 
different synthesizers.



group
A collection of applications within Program Manager. Grouping your applications makes them easier to 
find.



group icon          

A group window you have reduced to an icon in Program Manager.



group window          

A window that displays the items in a group within Program Manager. These items can be applications, 
files associated with applications, or a combination of both.



History button        

Displays a list of the HyperGuide topics you have viewed. Use this button to revisit any of the last 40 
HyperGuide topics you have viewed. The most recent topic appears first.



hotspot
Text, graphics, or parts of graphics that provide links to other HyperGuide topics or more information 
about the current topic.
Whether text or graphics, the pointer changes to the shape of a hand whenever it is over a hotspot. If 
you click a hotspot that is linked to another topic, that topic will appear in the HyperGuide window. If the 
hotspot is linked to more information, HyperGuide displays the information in a popup window on top of 
the HyperGuide window.



hue
The position of a color along the color spectrum.



HyperGuide button bar          
Contains the HyperGuide buttons you use to move among topics and contents screens. It is located 
near the top of the HyperGuide window.



icon          

A graphic representation of a disk drive, directory, group, application, document, and so on. You can 
restore an application icon to a window when you want to use the application.



insertion point          
The place where text will be inserted when you type.The insertion point usually appears as a flashing 
vertical bar in an application's window or in a dialog box. The text you type appears to the left of the 
insertion point, which moves to the right as you type.



International MIDI Association (IMA)
The non-profit MIDI organization that circulates information about the MIDI specification.



keymaps
Percussion instruments are key-based--each note plays a different percussion instrument. Keymaps 
translate MIDI key values to ensure the proper percussion instruments are used to play MIDI files. All 
MIDI files for Windows are authored using standard key assignments based on the General MIDI Mode 
standard.



keyword
Words in the HyperGuide Search dialog box that are associated with topics. Each application's 
documentation has its own keyword list, including the glossary words in HyperGuide. You select from the
list of keywords or type a keyword to see the list of topics associated with that keyword.



kilobyte
The measurement used for the size of a computer's memory, where 1 kilobyte (K) = 1,024 bytes.



list box          

A box within a dialog box that lists available choices--for example, the list of all available files in a 
directory. If all the choices don't fit in the box, there will be a vertical scroll bar to the right of the list box. 
In some list boxes, you can select more than one item.



local printer
A printer that is directly connected to your printer by a cable.



local queue          

Lists the files that you directed to any active printer connected to your computer. The computer and 
printers are connected locally by a cable.
When Print Manager starts printing on a local printer, its icon appears at the bottom of your screen. If 
you restore the icon to a window, you see the print queue for any active printer connected to your 
computer. You can use the Print Manager window to check the status of files in the print queue or to 
interrupt or cancel a print job.



luminosity
The brightness of the color on a scale from black to white.



maximize
To enlarge a window to its maximum size by using the Maximize button or the Maximize command.



Maximize button          

The small button at the upper-right corner of a window that contains an Up arrow. Mouse users can click
the Maximize button to enlarge a window to its maximum size. Keyboard users can use the Maximize 
command on the Control menu.



Media Control Interface (MCI)
A standard control interface for multimedia devices and files. MCI allows a multimedia application to 
easily control a variety of multimedia devices and files.



memory
The space in a computer where information is stored while you are working with it. Most PCs have a 
small amount of read-only memory (ROM), containing the built-in programs that start the operation of 
the computer when it is turned on, and a large amount of random-access memory (RAM) for users' 
programs and data.



menu          

A list of available commands in an application window. Menu names appear in the menu bar near the 
top of the window. The Control menu, represented by the Control-menu box at the left end of the title 
bar, is common to all Windows applications. You use a command on a menu by selecting the menu 
name, then choosing the command you want.



menu bar          
The horizontal bar containing the names of an application's menus. It appears just under the title bar.



menu command          

A word or phrase in a menu that you choose to carry out an action, such as copying a file.



menu name
The name for a particular menu that appears in the menu bar and opens a menu when you choose it.



menu title
A word or phrase in the menu bar that identifies a group of commands. Selecting the menu title causes 
the title to be highlighted and its menu of commands to appear below it.



MIDI
Musical Instrument Digital Interface. MIDI sets a communications standard for transferring data between
musical instruments and associated devices.



MIDI file
A file format for storing MIDI songs. In Windows, MIDI files have a .MID filename extension. 



MIDI Mapper
A Control Panel option that lets you create and edit MIDI setup maps. Windows uses these maps to 
translate and redirect MIDI data. 



MIDI Sequencer
Software that creates or plays songs stored as MIDI files. When a sequencer plays MIDI files, it sends 
MIDI data from the file to a MIDI synthesizer that produces the sounds. Windows provides a MIDI 
sequencer to play MIDI files.



MIDI Manufacturer's Association (MMA)
A collective organization composed of MIDI instrument manufacturers and MIDI software companies. 
The MMA works with the MIDI Standards Committee to maintain the MIDI specification. 



minimize
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



Minimize button          

The small button at the upper-right corner of a window that contains a Down arrow. Mouse users can 
click the Minimize button to reduce a window to an icon. Keyboard users can use the Minimize 
command on the Control menu.



movie file
A multimedia data file (for example, a file with the .MMM extension). You can play movie files with the 
Media Player accessory. Movie files are also called animations. 



MSCDEX
Microsoft Compact Disc Extensions. MSCDEX is software that makes CD-ROM drives appear to DOS 
as network drives. You must have MSCDEX installed on your computer for the CD-ROM drive to work. 



multimedia extensions
Additional features added to Windows version 3.0 that enable your computer to run animations, play 
sound and MIDI files, and display high-quality images. 



Multimedia PC
Multimedia personal computer. A multimedia computer satisfies a minimum set of hardware/software 
requirements necessary for multimedia computing. The requirements include:

An 80286/386/486 microprocessor running at 10MHz or faster
2MB or more of RAM
30MB or larger hard disk
VGA display
A digital audio subsystem
A CD-ROM drive
Systems software compatible with Microsoft Windows version 3.0 with multimedia extensions



multitasking
The ability of a single computer to perform several tasks simultaneously.
Multitasking makes it possible to print one document while editing another, or to perform lengthy 
computations while you work on something else.



network printer
A printer that is accessible to your computer only through a network.



network queue
Lists the files on the network server if you are using a network printer.



network server
A computer on a network that provides a particular service to other computers. For example, a disk 
server manages a large file server, and a print server manages a printer.



non-Windows application
An application that was not designed to run in Windows. Generally, non-Windows applications do not 
conform to Windows user-interface standards.



open
To display the contents of a directory or file in a window, or to enlarge an icon to a window.



option button           

A small round button that appears in a dialog box and is used to select an option. Within a group of 
related option buttons, you can select only one button.



palette
Defines the colors used in a bitmap image. Every device independent bitmap (DIB) has an associated 
color palette. 



parity
The method of detecting errors in data transmission.



patch
A specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as patches.



patchmaps
A patch is a specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as 
patches. Patchmaps translate MIDI patch changes to ensure the proper instruments are used to play 
MIDI files. All MIDI files for Windows are authored using standard patch assignments based on the 
General MIDI Mode standard.



pathname
The directions to a directory or file within your system. For example, C:\WINDOWS3\APPTS\JUNE.CAL 
is the pathname of the JUNE.CAL file in the APPTS subdirectory in the WINDOWS3 directory on drive 
C.



picture elements
The smallest graphics unit on the screen. Also known as pels.



pixels
The smallest graphic units on the screen. Also known as picture elements (pels).



playlist
A list of compact disc titles and tracks that determines the order in which the tracks on the disc are 
played. Playlists are only used in Music Box.
Use the Program button to assign or edit titles, and to change the playlist.



pointer          
In Windows, the shape of the pointer indicates its function.

For selecting Windows items, scrolling, resizing windows, 
and moving windows and dialog boxes with your mouse. 
This is the pointer you will see most often.

For choosing a HyperGuide hotspot.

For selecting text with your mouse.

For changing the size of a window with your mouse.

For changing the location or size of a window with your 
keyboard.

For indicating the application is processing your request.

port
A connection on a computer where you plug in a cable that carries data to a device.
LPT ports are parallel ports. COM ports are serial ports. EPT is a port used for certain printers, such as 
the IBM Personal Pageprinter. You can use the EPT port only if you have installed a special card in your 
computer.
Multimedia PCs also have a port for a MIDI sequencer.



print options
Printer-specific settings such as page orientation--portrait or landscape--or the manner in which paper 
feeds through the printer. These options vary from printer to printer.



printer-driver file
A file that gives Windows important information about how to control your printer, including details about 
printer features and the printing interface, descriptions of fonts (such as sizes and styles), character 
translations, and control sequences the printer uses to achieve various formats. Windows has printer-
driver files for most commonly used printers.



printer font
A series of dots connected by lines that can be scaled to different sizes. Another name for printer fonts is
vector (or stroke) fonts. Plotters typically use vector fonts.



printer queue information line          

Indicates the following:
The name of the printer.
Where the printer connects to your computer.
The current status of the printer.



program file          

A file that contains information that controls an application. In File Manager, each program file is 
represented by an icon. You can start the application by choosing the icon. Filenames for program files 
can have these extensions: .EXE, .COM, .PIF, and .BAT.



program information file (PIF)
A file that provides important information that Windows needs to run a non-Windows application. PIFs 
contain information such as the name of the file, a startup directory, whether the program writes directly 
to the screen or to memory, and multitasking options for applications running in 386 enhanced mode.



program item          

A program file or associated document represented by an icon in Program Manager. The program item 
provides the instructions Windows needs to start an application and open a document (if specified) when
you choose the icon.



program item icon          

An icon representing an application you can start or an associated document you can open from a group
in Program Manager. The program item provides the instructions Windows needs to start an application 
and open a document (if specified) when you choose the icon.



RGB components
The amount of each of the three primary colors--red, green, and blue--present in a color. Every color and
pattern is made by varying the three primary colors. This is true even in monochrome (black and white) 
mode. For instance, white is made by mixing together 255 parts of red, 255 parts of green, and 255 
parts of blue. Black, on the other hand, is 0 red, 0 green, and 0 blue.



read-only
Describes a file or CD-ROM disc that can only be opened and read. You cannot edit a read-only file or 
CD-ROM disc and save your changes.



real mode
An operating mode that Windows runs in to provide maximum compatibility with versions of Windows 
applications released prior to Windows version 3.0. Real mode is the only mode available for computers 
with less than 1 MB of extended memory.



Restore button          

The small button at the upper-right corner of a window that contains both an Up arrow and a Down 
arrow. The Restore button appears only after you have enlarged a window to its maximum size. Mouse 
users can click the Restore button to return the window to its previous size. Keyboard users can use the 
Restore command on the Control menu.



root directory
The main directory on a disk. The root directory is created at the first level when you format a disk. The 
symbol used to indicate the root directory of a disk is the backslash (\). For example, the root directory 
for drive C is noted as C:\.



sample
A piece of waveform data represented by a single numerical value. You convert sound into digital form 
by taking samples of the sound at specific time intervals and converting them to numeric values.



saturation
The purity of a hue, moving from gray to the pure color.



scaled font size
A font size that approximates a specified font size for use on the screen. Windows scales larger font 
sizes when a size that is available for the printer is not available for the screen. Scaled fonts may look 
slightly different from unscaled fonts. When you choose a smaller font size that is available for the printer
but not for the screen, Windows substitutes the correct size from a precision-drawn font that resembles 
the selected font as closely as possible.



screen font
A font that duplicates a printer font on your screen.

If you choose a printer font that does not have a corresponding screen font, Windows substitutes a 
screen font that closely resembles the printer font. The substitute font duplicates the line lengths and 
page breaks of the font you selected.
When you purchase extra fonts from a printer or font manufacturer, ask about the availability of screen 
fonts to match.



screen saver
An image or pattern that is shown on your computer screen during periods of inactivity. Screen savers 
hide information currently on the screen; by changing patterns they can also save wear on the 
electronics in the display.



scroll arrow          

An arrow on either end of a scroll bar that is used to scroll through the contents of a window or list box. 
Clicking a scroll arrow moves the contents one line. Holding down a scroll arrow scrolls the contents 
continuously.
Scroll arrows also control the playing of media in some applications, such as Media Player and Sound 
Recorder.



scroll bar          
A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box, which allow you to scroll within the window or
list box.
A scroll bar is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



scroll box          

The square or rectangular box within a scroll bar that indicates your relative position within a document 
or list box. Mouse users can drag the scroll box up or down quickly through long documents.
A scroll box is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



Search button          

Displays the keywords you can use to search for topics. Use this button to look for topics related to a 
keyword.



select
To mark an item by highlighting it with key combinations or with a mouse. Selecting does not initiate an 
action. After selecting an item, you choose the action that affects or involves the item. For example, you 
can select text and then choose the Copy command to copy the text onto the Clipboard.



selection cursor          
The marking device that shows where you are in a window, menu, or dialog box and what you have 
selected. The selection cursor appears as a dotted box around the text in a dialog box option.



serial ports
Ports used by your system, named COM1, COM2, and so on. Serial ports are typically used for 
connecting modems, mouse devices, and some kinds of printers.



shortcut key          

A key or key combination, available for some commands, that you can press to carry out a command 
without first selecting a menu. The shortcut key for a command is listed to the right of the command 
name on the menu.



shrink
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



simple device
Devices, such as audio compact-disc players, that don't have an associated file and can be opened 
without a filename specification.



solid color
A color directly supported by your display.



source directory
The directory containing the file or files you intend to copy or move.



spin box          

A spin box shows one item in a range of possible choices. Clicking the Up or Down arrow to the right of 
the entry lets you "spin" through the available choices until your choice appears in the display rectangle.



standard mode
The normal operating mode for running Windows. This mode provides access to extended memory. In 
standard mode, you can also switch among non-Windows applications.



status bar          
A line of information located at the top or bottom of a window. For example, in a directory window the 
status bar tells how many files are selected, how much disk space they occupy, and the total number of 
files in the directory. In the Directory Tree window, the status bar shows the number of bytes available on
the disk and the total disk capacity. Not all windows have a status bar.



stop bits
The timing unit between characters.
Stop bits are not actually bits; they determine the time between transmitted characters.



synthesizer
An electronic instrument able to make music and sounds by creating its own audio waveforms and 
sending them out to an audio system. A synthesizer can play back MIDI files.



Task List
A window that shows all the applications you have running so you can switch among them. You can 
open the Task List window by choosing Switch To from the Control Menu or by pressing CTRL+ESC.



text box          

A box within a dialog box where you type the information needed to carry out a command. When the 
dialog box appears, the text box may be blank or may contain text.



text file
A file containing only plain text, numbers or symbols. The text in a text file is uniform and does not 
contain any formatting, such as bold, underline, or different fonts and font sizes. A text file usually 
consists of characters coded from the ASCII character set. 
The advantage of a text file is that it can be transferred to almost any text editor or word processor. Also,
MS-DOS and Windows use text files, such as AUTOEXEC.BAT, CONFIG.SYS, and WIN.INI.



title
Another name for a software application written to run on a Multimedia PC. 



title bar          
The horizontal bar at the top of a window that contains the title of the window or dialog box. On many 
windows, the title bar also contains the Control-menu box and Maximize and Minimize buttons.



topic
The level in the HyperGuide hierarchy at which you see information in the main window. This information
can be in the form of a Quick Look graphic, an explanation of a command, a conceptual overview, a 
procedure, or a table of keys. Information in pop-up windows and contents screens are not considered 
topics.



track
A sequence of sound on a CD disc, which usually corresponds to a song.



Up button          

Moves up one level in the HyperGuide hierarchy.



vector fonts
A series of dots connected by lines that can be scaled to different sizes.



virtual memory
A memory management system used by Windows running in 386 enhanced mode, which allows 
Windows to behave as if there were more memory than is actually present in the sytem. Virtual memory 
equals the amount of free RAM plus the amount of disk space allocated to a swap file that Windows 
uses to simulate additional RAM.



volume label          
The name you give a disk by using the Label command. Disk labels are optional. You see this 
information in File Manager only if you assigned a label to your disk. You can change or add a disk label 
through File Manager.



WAVE format
Microsoft's format for digitized waveform files. These files have a .WAV extension.



waveform
A sound waveform displays variances in air pressure over time. An audio signal waveform displays 
variances in voltage over time.



wildcard characters
Two MS-DOS characters you can substitute for all or part of a file or directory name when you want to 
find similarly-named files or want one command to affect a number of files or directories.
An asterisk (*) substitutes for all characters. A question mark (?) substitutes for a single character.
For example, this entry covers all files with a .DOC extension in the current directory:

*.DOC
And this entry covers everything named with FY, three other characters, and the extension .90:

FY???.90



window
A rectangular area on your screen in which you view an application or document. You can open, close, 
and move windows, and change the size of most windows. You can open several windows on the 
desktop at the same time and you can shrink windows to icons or enlarge them to fill the entire desktop.



window border          
The outside edge of a window. You can lengthen or shorten each border. You can also change the width 
of the border with Control Panel's Desktop command.



Windows application
An application that was designed for Windows and will not run without Windows. All Windows 
applications follow the same conventions for arrangement of menus, style of dialog boxes, use of the 
keyboard and mouse, and so on.



wrap
The automatic movement of the insertion point from the end of one line to the beginning of the next line 
as you type. When text wraps, you do not need to press ENTER at the end of each line in a paragraph.






